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About this Book and the Library

The NetlQ Analysis Center User Guide provides conceptual information about the NetlQ Analysis
Center product (Analysis Center), an overview of Analysis Center components, and instructions for
configuring and generating reports.

Intended Audience

This book provides information for individuals responsible for reporting with Analysis Center.

Other Information in the Library

The library provides the following information resources:

NetlQ Analysis Center Administrator Guide

This book is intended for system administrators responsible for installing and configuring
Analysis Center to enable users to report on AppManager data.

Help

Provides context-sensitive information and step-by-step guidance for common tasks, as well as
definitions for each field on each window.

The Analysis Center library is available in Adobe Acrobat (PDF) format from the Analysis Center
Documentation page of the NetlQ website.

About this Book and the Library
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About NetlQ Corporation

We are a global, enterprise software company, with a focus on the three persistent challenges in your
environment: Change, complexity and risk—and how we can help you control them.

Our Viewpoint

Adapting to change and managing complexity and risk are nothing new

In fact, of all the challenges you face, these are perhaps the most prominent variables that deny
you the control you need to securely measure, monitor, and manage your physical, virtual, and
cloud computing environments.

Enabling critical business services, better and faster

We believe that providing as much control as possible to IT organizations is the only way to
enable timelier and cost effective delivery of services. Persistent pressures like change and
complexity will only continue to increase as organizations continue to change and the
technologies needed to manage them become inherently more complex.

Our Philosophy

Selling intelligent solutions, not just software

In order to provide reliable control, we first make sure we understand the real-world scenarios in
which IT organizations like yours operate — day in and day out. That's the only way we can
develop practical, intelligent IT solutions that successfully yield proven, measurable results. And
that's so much more rewarding than simply selling software.

Driving your success is our passion

We place your success at the heart of how we do business. From product inception to
deployment, we understand that you need IT solutions that work well and integrate seamlessly
with your existing investments; you need ongoing support and training post-deployment; and you
need someone that is truly easy to work with — for a change. Ultimately, when you succeed, we
all succeed.

Our Solutions

+ Identity & Access Governance

+ Access Management

+ Security Management

+ Systems & Application Management
+ Workload Management

+ Service Management

About NetlQ Corporation 7
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Contacting Sales Support

For questions about products, pricing, and capabilities, contact your local partner. If you cannot
contact your partner, contact our Sales Support team.

Worldwide: www.netig.com/about_netig/officelocations.asp
United States and Canada: 1-888-323-6768
Email: info@netig.com
Website: www.netig.com

Contacting Technical Support

For specific product issues, contact our Technical Support team.

Worldwide: www.netig.com/support/contactinfo.asp
North and South America: 1-713-418-5555

Europe, Middle East, and Africa: +353 (0) 91-782 677

Email: support@netig.com

Website: www.netig.com/support

Contacting Documentation Support

Our goal is to provide documentation that meets your needs. The documentation for this product is
available on the NetlQ website in HTML and PDF formats on a page that does not require you to log
in. If you have suggestions for documentation improvements, click comment on this topic at the
bottom of any page in the HTML version of the documentation posted at www.netig.com/
documentation. You can also email Documentation-Feedback@netig.com. We value your input and
look forward to hearing from you.

Contacting the Online User Community

NetlQ Communities, the NetlQ online community, is a collaborative network connecting you to your
peers and NetlQ experts. By providing more immediate information, useful links to helpful resources,
and access to NetlQ experts, NetlQ Communities helps ensure you are mastering the knowledge you
need to realize the full potential of IT investments upon which you rely. For more information, visit
community.netig.com.

About NetlQ Corporation
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Introducing Analysis Center

Analysis Center imports raw data from AppManager repositories, transforms the data into useful
information about the computing infrastructure that supports your business, and publishes that
information in graphical or tabular reports.

You can use these reports to:

*

Track performance: Are my Web servers operating within the limits of current system
resources? Is there any degradation of throughput on my network?

Uncover trends: Is there an increase in the number of HTTP requests handled by my Web
servers? Is there an increase in the number and size of messages conveyed by my Exchange
Servers?

Correlate events: Does the volume of customer traffic during the holiday shopping season
overwhelm the memory and CPU of my Web servers? Does an increase in the number and size
of messages conveyed by my Exchange Servers have a negative impact on network
performance?

Make forecasts: At what point will customer traffic outpace the system resources on my Web
servers and when should | upgrade? At what point will the increase in size and number of
messages conveyed by my Exchange Servers have a degrading effect on network throughput
and when should | upgrade?

Track security events: Has there been an unusual number of failed login attempts? Are my
Web servers subject to frequent port scanning?

Analysis Center is built around Microsoft SQL Server, SQL Server Analysis Services, and SQL Server
Reporting Services. Employing these technologies facilitate the transfer and manipulation of large
amounts of data. It also ensures rapid retrieval of information and provides reports of up-to-the minute
analyses of your enterprise.

*

*

Section 1.1, “Analysis Center Architecture,” on page 10

Section 1.2, “Analysis Center Components,” on page 10

Introducing Analysis Center
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1.1 Analysis Center Architecture

Analysis Center includes a number of software components that you can install on one computer or
distribute across multiple computers. The following figure illustrates the Analysis Center architecture.

Analysis Center
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Data is copied from the source databases (AppManager repositories) to the Data Marts and from the
Data Marts to the Data Warehouse. Admin Console enables you to perform administrative tasks on
the Data Warehouse using the OLAP server and the Analysis Center Warehouse. Reporting Console
connects to the Data Warehouse and OLAP through the Web Service to enable you to configure and
run reports. The Operations Center Dashboard connects to the Web Service and enables you to view
and manipulate the reports. The Data Extension connects with the Web Service to publish, print, and
provide Web access to reports by using SQL Reporting Services. For more information about the
data connections and data flow among the various Analysis Center components, see Understanding
Data Connections and Flow in the NetlQ Analysis Center Administrator Guide.

1.2 Analysis Center Components

This section describes the components of Analysis Center.

¢ Section 1.2.1, “Data Mart,” on page 11

¢ Section 1.2.2, “Data Warehouse,” on page 11

+ Section 1.2.3, “Reporting Center Configuration Database,” on page 12

+ Section 1.2.4, “Web Service,” on page 12

+ Section 1.2.5, “SQL Reporting Services and Data Extension,” on page 12
+ Section 1.2.6, “Admin Console,” on page 12

Introducing Analysis Center
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1.2.2

+ Section 1.2.7, “Reporting Console,” on page 12
+ Section 1.2.8, “Operations Center Dashboard,” on page 13

Data Mart

Data Mart is a SQL Server database that Analysis Center creates for each AppManager Data Source.
A Data Mart collects and processes data from Data Sources, and then stores it in fact and dimension
tables to be used by the Data Warehouse. A Data Mart serves the following purposes:

+ Stores the data copied from the source databases for processing.

+ Stored procedures process the copied data.

+ Fact and dimension tables store the processed data.

+ The fact tables function as a component of the Data Warehouse

The SQL Server agent uses SQL Server Integration Services (SSIS) packages to copy the data from
the Data Source to the Data Mart, and then to the Data Warehouse.

Data Warehouse

The Data Warehouse consists of two relational databases and a multidimensional database. The
AC_War ehouse and AC_CLAP databases are used for AppManager reporting.

The AC_Configuration relational database includes:
+ The status of the SSIS packages that are responsible for copying data from one database to
another.
+ Custom schedule configuration.
The relational database AC War ehouse serves as the immediate source of data for the

multidimensional database and is managed by Microsoft SQL Server. It contains the dimensional
data copied from the Data Marts and views linked to the fact tables in the Data Marts.

The multidimensional database AC_OLAP is managed by Microsoft SQL Server Analysis Services. It
contains aggregations (for example, maximum, minimum, average) of the data copied from the
source databases. These aggregated values are stored in cubes designed to facilitate the rapid query
of large amounts of data.

Each Data Mart contains the following cubes:

+ Data organized by the local time on the AppManager computer.

+ Data organized by the UTC time (Greenwich Mean Time).
A cube is a structure for data that uses hierarchical dimensions as an organizing principle.

Dimensions describe data from a particular point of view. For example, the computer and application
from which it was generated, or the date and time during which it was generated. The hierarchical
structure of dimensions allows you to select data from any point in the hierarchy. For example, all
data generated during 2005; all data generated during December 2005; or all data generated
December 1, 2005. Given this structure and organization of aggregate values you can create reports
such as the following:

+ The average, minimum, and maximum use of memory resources by all Exchange Servers for the
year 2005.

Introducing Analysis Center 11



1.2.3

1.2.4

1.2.5

1.2.6

1.2.7

+ The average growth rate for all SQL Server databases for the month of December 2005.
+ The average daily use of CPU for all Domino servers for 2004 and 2005.

Reporting Center Configuration Database

The NQRConfig relational database includes:
+ Analysis Center security information, such as the level of privileges for each Analysis Center role
and which users are assigned to which roles.

+ Connection information such as the SQL server and database names used during the
generation of AppManager reports.

+ The status of scheduled reports.

Web Service

The Web Service runs on a Microsoft Internet Information Services (IIS) Web server and is the
centralized point of access to all your databases. It serves as the layer between the Reporting
Console and the source databases, running the SQL queries that gather report data, and then
returning the data to the Console. In addition to authenticating source database connections, it also
authenticates connections to the Reporting Services Data Extension, which in turn publishes your
reports to SQL Server Reporting Services (SSRS).

SQL Reporting Services and Data Extension

Reporting Center allows you to deploy reports to SSRS that lets you create and manage reports, and
deliver them on a schedule. When you deploy a report from Reporting Center, the Reporting Services
Data Extension communicates with SSRS through the Reporting Center Web Service to deliver the
information. SSRS publishes the report that you can view in a Web browser.

Admin Console

Admin Console lets you perform the following administrative tasks:

¢+ Managing Data: Lets you clean up data, rename or delete metrics, and delete machines.
+ Managing Data Sources: Lets you add, delete, enable, or disable Data Sources.

+ Managing ETL Filters: Lets you view or modify existing ETL filters, define new filters, or
disable filters. ETL filters let you control the amount of data that Analysis Center collects from
AppManager.

+ Managing Jobs: Lets you view jobs. You can also start, stop, enable, or disable jobs.

+ Data Processing: Lets you to reprocess the OLAP partitions when you want to optimize
Analysis Center performance.

+ Migrating Reports: Lets you migrate the Analysis Center 2.9 or later reports to Reporting
Center.

Reporting Console

Reporting Console lets you run and generate reports. Use the Console to perform the following tasks:

+ Customize the look and feel of a report

12 Introducing Analysis Center



1.2.8

+ Determine the amount of data displayed in a report

*

Create dashboard reports that contain multiple related reports

*

Configure deployment settings
+ Configure subscriptions for SSRS

*

Set the report context such as setting a time frame and selecting data series

Operations Center Dashboard

The Dashboard is a web application, which also functions as a client to the Operation Center Server.

The Operations Center Server, the Dashboard Application, and the Dashboard Client are the
components of the Operations Center solution. The Operations Center Server connects to the Web
Service, which collects the data and displays the reports in the Dashboard client.

For more information on Operations Center Dashboard, see the Operations Center Dashboard
Guide.

Introducing Analysis Center

13


https://www.netiq.com/documentation/operations-center-57/dashboard/data/bookinfo.html
https://www.netiq.com/documentation/operations-center-57/dashboard/data/bookinfo.html

14 Introducing Analysis Center



2.1

Navigating the Reporting Console

This chapter provides information about how to use the Reporting Console to perform tasks such
managing Data Source connections, setting security permissions, configuring reporting services.

+ Section 2.1, “Starting Reporting Center,” on page 15
+ Section 2.2, “Navigating Reporting Console,” on page 16
+ Section 2.3, “Using the Reporting Console,” on page 17

Starting Reporting Center

When you log in to the Reporting Console, the Web Service uses IIS to validate the account
credentials based on the Web Service configuration details you provided during installation.

To start Reporting Center:

1 Log in to the computer where you installed the Reporting Console.

2 Launch the programs on the Start menu and click NetlQ > NetlQ Reporting Center > Reporting

Center Console.

3 Provide the required information in the Logon dialog box and click Logon.

Field Description

Web Service Enter the URL of the Reporting Center Web Service in the following format:
ht t p: / / computer hosting Web Service/Web Service virtual directory.

The URL is defined during the installation of the Web Service.

Use Current Windows Select this option to log on with the Windows account that you used to log
Account Credentials into the domain.

Clear this option to enable the User name and Password options.

User name Specify the login name for the account you want to use to connect to the
Web Service using the format domain\user name.

Password Specify the password for the account you want to use to connect to the Web
Service.

Sign me in automatically | Select this option to automatically sign you in during your subsequent logins
in the following scenarios:

+ You connect to the same Web Service

* You use your current Windows credentials to connect to the Web
Service

However, if you start the Console using a different Windows account, the
Console does not automatically sign you in and displays the Login dialog
box.

Navigating the Reporting Console
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2.2

221

2.2.2

2.2.3

Navigating Reporting Console

Reporting Console consists of three panes from which you can perform all the tasks related to Data
Source Connections, Security Settings, and Reports.
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Navigation Pane

The Navigation pane is the starting point for Reporting Console. Use the Navigation pane to initiate
tasks such as choosing a data source connection and selecting a report. The information in the other
panes change according to what you do in the Navigation pane.

Reporting Center Home is at the top of the Navigation Tree and allows you to start managing security,
data source connections, and reports. When you click Reporting Center Home from the Navigation
Pane or the toolbar, the Reporting Console displays links to start each of the tasks, along with
information about your current security settings, data source connections, and reports.

Results Pane

The center of the Reporting Console contains the Results pane that displays information related to
the folder, report, or data source connection you select in the Navigation pane. For example, this
pane displays the contents of a report or the details of a data source connection. When you modify
report properties in Reporting Console and run a report, the Results pane displays the report with the
changes.

Tasks Pane

The Tasks pane contains common functions you perform in Reporting Console. The contents change
according to what you select in the Navigation pane. For example, if you select an individual report in
the Navigation pane, the Tasks pane displays a list of the report-related tasks along with the Report
Context tab, which contains the context controls for the report.

16 Navigating the Reporting Console



2.3 Using the Reporting Console

Use the Reporting Console to set up your reporting environment:

+ Section 2.3.1, “Managing Data Source Connections,” on page 17
+ Section 2.3.2, “What's Next?,” on page 18

2.3.1 Managing Data Source Connections

Data Source connections are the basis for the reports that you run with Reporting Center. The setup
program automatically configures your initial data source connections according to the information
you provide during installation. These data source connections point to specific database servers that
provide the data for your reports. Data source connections use either Windows authentication or SQL
authentication depending on the security configuration of the source SQL Server and the choices you
make when installing SQL Server. After installation, you can configure additional data source
connections and modify connection properties in the Reporting Console.

Adding a New Data Source Connection

1 In the Navigation pane of the Reporting Console, right-click Data Source Connections and click
Add New Data Source Connection.

2 Click the General tab.
3 Specify the Data Source connection name and description.

4 (Conditional) If you want to set this Data Source connection as default, select the Default
Connection option.

5 Select the Data Source Type as Analysis Center.
6 Inthe SQL tab of the Connection Details panel, specify the following:

6a Inthe Server Name option, specify the SQL Server Instance name where AC_Warehouse is
installed.

6b In the Database Name option, specify AC_ Warehouse.
6¢c Select the authentication type.

6d (Conditional) If you chose SQL Server Authentication, then specify the credentials to log
into the SQL Server.

7 Inthe OLAP tab of the Connection Details panel, specify the following:

7a In the Server Name option, specify the SQL Server Instance name where AC_OLAP is
installed.

7b In the Database Name option, specify AC_OLAP.
8 Click OK.

Specifying a Default Data Source Connection

Before you run reports for the first time, NetlQ Corporation recommends that you specify a default
data source connection for each connection type.

To specify a default connection:

1 In the Navigation pane of the Reporting Console, click Data Source Connections and right-click
a connection.

Navigating the Reporting Console 17



2 Click Data Source Connection Properties > General and select Default Connection.

3 Click OK.

2.3.2 What's Next?

After you install Reporting Center and get familiar with the Console and Data Source connections, get
started with performing the following tasks. This is a suggested order, but the order in which you
perform these tasks might vary depending on your organization requirements:

1 Create reports from templates provided. For more information, see Chapter 3, “Understanding
Report Templates,” on page 19.

2 Deploy a report to SSRS and set up a subscription for it. For more information, see Section 4.5,
“Deploying Reports,” on page 33.

3 Create a hierarchy of Reporting Center users and groups. For more information, see Configuring
Reporting Center Security in the NetlQ Analysis Center Administrator Guide.

4 Set up permission sets for the users and groups and assign them to objects. For more
information, see Configuring Reporting Center Security in the NetlQ Analysis Center
Administrator Guide.

18 Navigating the Reporting Console
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3.1

3.11

Understanding Report Templates

Analysis Center 3.0 includes report templates that you can use as a base to create your own reports.
These templates are available in the AppManager Templates folder located in the Navigation pane of
the Reporting Console.

+ Section 3.1, “Derivation Templates,” on page 19

+ Section 3.2, “Non-Derivation Templates,” on page 22

Derivation Templates

Derivation templates are one-to-many templates that let you derive multiple reports from a single
template. The default report that generates when you run the template displays all the contexts (data
series) applicable for the template as headers in the table view. To derive a new report from the
template, manipulate the presentation of the data series in the default report.

For example: Aggregate Template is a Derivation template that you can use to derive reports
displaying AppManager data in the following combinations:

+ Knowledge Script on X-axis and Machines on Y-axis or vice-versa.

+ Knowledge Script on X-axis and Measure on Y-axis or vice-versa.

+ Machine on X-axis and Measure on Y-axis or vice-versa.

For more information about deriving new reports from a Derivation template, see Section 3.1.1,
“Deriving New Reports From Derivation Template,” on page 19.

Deriving New Reports From Derivation Template

1 In Reporting Console, select the template from which you want to derive the report.
2 Click Run Report.
3 Manipulate the report data presentation:

3a Inthe Data Presentation option, select Cross Bound.

3b Inthe Grouping Data Series option, select the data series by which you want to group the
data on Y-axis.

3c Inthe X-Axis Data Series option, select the data series that you want to display on X-axis.

3d In Data Data Series option, select AggregateDateSourcel, which provides the aggregate
value of all the AppManager Data Sources.

4 Click OK.
5 Click the Report > Save Template As Report option and save the report.

6 (Conditional) To derive multiple reports from the template, repeat Step 1 through Step 5 for every
new report you want to derive.

Understanding Report Templates 19



3.1.2 Types of Derivation Templates

20

The following sections list the templates that you can use to derive multiple reports. For information
about deriving reports from a Derivation template, see Section 3.1.1, “Deriving New Reports From
Derivation Template,” on page 19.

+ “Aggregate Templates” on page 20

+ “Day of the Week Templates” on page 21

+ “Time Range Templates” on page 21

Aggregate Templates

Template Name Description

Aggregate Tenpl ate Generates a default report that displays AppManager data for
the Knowledge Script, Machine, and Measure data series.

To derive a new report, manipulate the data presentation of any
two of the following data series, which you want to display in the
new report:

+ Knowledge Script
+ Machine

* Measure

Aggregate Tenplate Metric Generates a default report that displays AppManager data for
the Machine, Measure, and Metric data series.

To derive a new report, manipulate the data presentation of any
two of the following data series, which you want to display in the
new report:

+ Machine
+ Measure

* Metric

Understanding Report Templates



Day of the Week Templates

Template Name

Description

Day of the Week Template

Generates a default report that displays AppManager data for the
Knowledge Script, Machine, and Measure data series over
different week days.

To derive a new report for different week days, manipulate the
data presentation of any one of the following data series by which
you want to group the data in the new report:

* Knowledge Script
+ Machine

+ Measure

Day of the Week Template Metric

Generates a default report that displays AppManager data for the
Metric data series over different week days.

To derive a new report for different week days, manipulate the
data presentation to group the data by Metric data series in the
new report.

Time Range Templates

Template Name

Description

Time Range Template

Generates a default report that displays AppManager data for
the Knowledge Script, Machine, and Measure data series over a
specific time range.

To derive a new report over a specific time range, manipulate the
data presentation of any one of the following data series by
which you want to group the data in the new report:

+ Knowledge Script
+ Machine

¢ Measure

Time Range Template Metric

Generates a default report that displays AppManager data for
the Metrics data series over a specific time range.

To derive a new report for a specific time range, manipulate the
data presentation to group the data by Metric data series in the
new report.

Understanding Report Templates
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3.2

3.2.1

3.2.2

Non-Derivation Templates

Non-Derivation templates are one-to-one templates that lets you derive one report per template. After
you derive a report from the template you must save the derived report before you deploy it. For more
information about deriving a new report from a Non-Derivation template, see Section 3.2.1, “Deriving
a Report From the Non-Derivation Template,” on page 22.

¢ Section 3.2.1, “Deriving a Report From the Non-Derivation Template,” on page 22

¢ Section 3.2.2, “Types of Non-Derivation Templates,” on page 22

Deriving a Report From the Non-Derivation Template

1 In Reporting Console, select the template from which you want to derive the report.
2 Click Run Report.

3 Click the Report > Save Template As Report option and save the report.

Types of Non-Derivation Templates

The following sections lists the templates that you can use to derive a report:

+ “Compare Templates” on page 23
+ “Dashboard Templates” on page 24
+ “Drill-Down Templates” on page 24
+ “GAP Templates” on page 25

+ “Prediction Templates” on page 25
+ “Target Templates” on page 25

+ “Top N Templates” on page 25

+ “UpTime Templates” on page 26

22 Understanding Report Templates



Compare Templates

Template Name

Description

KS Conpare By Number Tine Range

Generates report that compares AppManager data for the
Knowledge Script data series over different time range:

KS Compare By Two Ti ne Range:

Generates reports that compares AppManager data for the
Knowledge Script data series over two different time
range.

KS Compare By Three Tine Range:

Generates reports that compares AppManager data for the
Knowledge Script data series over three different time
range.

KS Conpare By Four Time Range:

Generates reports that compares AppManager data for the
Knowledge Script data series over four different time
range.

Machi ne Conpare By Nunber Tinme
Range

Generates reports that compares AppManager data for the
Machine data series over different time range:

Machi ne Conpare By Two Time Range:

Generates reports that compares AppManager data for the
Machine data series over two different time range.

Machi ne Conpare By Three Time Range:
Generates reports that compares AppManager data for the
Machine data series over three different time range.

Machi ne Conpare By Four Time Range:

Generates reports that compares AppManager data for the
Machine data series over four different time range.

Metric Compare By Nunber Tine
Range

Generates reports that compares AppManager data for the
Metric data series over different time range:

Metric Conpare By Two Tinme Range:

Generates reports that compares AppManager data for the
Metric data series over two different time range.

Metric Conmpare By Three Time Range:
Generates reports that compares AppManager data for the
Metric data series over three different time range.

Metric Conpare By Four Tinme Range:

Generates reports that compares AppManager data for the
Metric data series over four different time range.

Understanding Report Templates
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Dashboard Templates

Dashboard template enables you to create a dashboard report that lets you group a number of
reports. This grouping of reports helps you view all the reports on the same page, which makes it
easy to view related data at a glance. You can add or remove reports from a dashboard and also save
the dashboard with a different name. For more information about Dashboard Reports, see

Section 4.3, “Using Dashboard Reports,” on page 31.

Drill-Down Templates

Drill-Down templates enables you to create drill-down reports. Reports often display large amount of
data. If the data is fairly detailed, displaying every detail in one report might not be possible. The best
solution to overcome this problem is to create a Table of Contents (TOC) report and a drill-down
report. The TOC report displays computer data for the selected context and allows you to navigate to
the drill-down report to view the underlying data. The drill-down report displays detailed information
about the machine you select.

Template Name Description

Machine Group By Measure Generates a drill-down report in which each row represents a
Machine or Machine Group and each column represents the
Measure data series.

TOC List By Server Generates a parent report in which each row represents
machine details with a link to view the drill-down report. Each
column in the report represents the Measure data series.

To link the drill-down report:

1. Right-click the Machine header in the table view.
2. Click Data Series Properties > General.

3. Inthe Linked Subreport option, click Sub Report and
select the report to link with the parent report.

4. Click OK twice.
NOTE: You can also use this report to create Linked report. For

more information about Linked Reports, see Section 4.2, “Using
Linked Reports,” on page 30.
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GAP Templates

To set thresholds for what you consider good and poor performance, click Report Contexts > Reports

Parameters.

Template Name

Description

Good-Acceptable-Poor Performance Data

Examines relative levels of performance based on the data
collected from the machines. Displays overall values in
percentage for the selected machine.

Good-Acceptable-Poor Performance Data
By Machine

Examines relative levels of performance based on the data
collected from the machines. Displays overall values for each
selected machine.

Good-Acceptable-Poor Performance Data
Over Time

Examines relative levels of performance based on the data
collected from the machines. Displays a set of values per time
increment for each selected machine.

Prediction Templates

Template Name

Description

Performance Data Trend and Prediction

Generates report that plots a trend line based on a range of all
available data.

Performance Data Trend and Prediction
(Normalized)

Generates report that plots a trend line based on a range of
existing and normalized data. That is, the data which excludes
extreme and isolated values.

Target Templates

Template Name

Description

Performance Relative to Target

Generates report that tracks performance relative to a
benchmark and displays values as the percentages by which
the target value was exceeded.

Top N Templates

Template Name

Description

Bottom N Performance Server

Generates report that lists the computers with the lowest
values for the selected metrics. N represents the number of
machines.

Top N Performance Server

Generates report that lists the computers with the highest
values for the selected metrics. N represents the number of
machines.
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UpTime Templates

Template Name

Description

System Uptime

Generates report that lists the total system uptime and
downtime for computers or computer groups over the time
period you specify and displays the following:

+ System Total Time (hours)
+ System Downtime (hours)
+ System Uptime (hours)
+ System Downtime (%)

+ System Uptime (%)

System Uptime By Server

Generates report that examines the percentage of uptime
and downtime per machine or machine group for the time
period you specify. Displays the following two values per

machine or machine group for the time period you specify:

+ System Downtime (%)

+ System Uptime (%)

System Uptime By Over Time

Generates report that examines the percentage of system
uptime and downtime by time interval for machine or
machine groups over the time period you specify. Displays
the following two values per time interval for all selected
computers:

+ System Downtime (%)

+ System Uptime (%)

System Uptime Pie Chart

Generates report that examines the percentage of uptime
and downtime for an individual machine or machine group for
the time period you specify. Displays the following two overall
values for the time period you specify:

+ System Downtime (%)

+ System Uptime (%)

NOTE: You can include multiple machine or machine groups,
but a single pie chart is not suited to illustrate multiple 100%
totals. If you want to use this report for multiple machine or
machine groups, use a different chart type.
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Working with Reports

This section provides information about how to configure, run, and deploy the reports. Analysis
Center provides report templates from which you can derive your own reports. For more information,
about the templates, see “Understanding Report Templates” on page 19.

+ Section 4.1, “Understanding Reports,” on page 27

+ Section 4.2, “Using Linked Reports,” on page 30

+ Section 4.3, “Using Dashboard Reports,” on page 31
+ Section 4.4, “Migrating Reports,” on page 32

+ Section 4.5, “Deploying Reports,” on page 33

Understanding Reports

Reports display the data extracted from AppManager databases in tables or graphically in charts. The
Reporting Console allows you to configure various aspects of the presentation of your reports. For
example: color scheme, type of chart, and the display of the X-axis and Y-axis, data points, data
streams, legends, and titles.

In addition, you can generate new columns for your tables just using the Console, without depending
on SQL queries defined into the reports. You can easily create multiple reports from the same report
and add them to a dashboard report that contains reports with related information.

When you select a report, the Reporting Console displays the report in the Results pane, and the
contexts of the report in the Tasks pane. To customize the appearance of the report and the data
displayed, you can configure the report contexts and properties. After you modify a report, you must
save it to retain the changes. Saving also automatically redeploys reports that you previously
deployed to SSRS, so you typically do not need to manually redeploy reports after modifying them in
the Console.

If you previously set up a subscription for a report and you modified the report in the Console, you
must manually redeploy it to reset the subscription. Also, if you modified the data displayed (for
example, by changing the Data Query Limit context value), then you must also run the report to
update it.

Report Contexts

Report contexts include the data controls such as the Data Source connection, time frame, query limit
defined in the report. These contexts are displayed in the Tasks > Report Context of the Reporting
Console.The information in the Report Context tab changes according to the definitions specified in
each report. You can modify most contexts to customize the data displayed in your report. For
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contexts with a tree, such as Machine and Knowledge Script, you can filter the nodes to display
specific data and perform a search on the context tree. For more information about setting the report
context, Section 5.2, “Setting the Context For a Report,” on page 37.

Reporting Console includes the following Report Contexts:

+ Data Source Connection: Lists the sources of data for your report. If there is more than one
connection available, you can select the Data Source Connection that Reporting Center should
use to retrieve data for the report.

¢ Data Source: Lists the available AppManager repository.

+ Knowledge Script: Lists all the AppManager Knowledge Script that are available both in the
Cube and the Warehouse.

¢ Group: Lists all the AppManager machines and machine groups. The machine and machine
groups are filtered based on the selected Knowledge Scripts.

+ Metric: Lists the AppManager static and dynamic legends of the following types:

+ AM Event Count

+ AM Event Occurrence

¢+ AM NT Performance Data

+ AM Unix Performance Data

The metrics are filtered based on the selected machines and machine groups.

+ Measures: Lists the statistics for computing data:

+ Average

+ Count

¢+ Maximum

¢ Minimum

¢ Standard Deviation

¢ Sum

+ Time: Allows you to specify the date and time range for a report. You can customize the date
and time or choose from predefined ranges. You can also define the interval at which you want to
aggregate data in your report. For example, if you specify a time range of 12 months, data is
aggregated by month rather than day. You can limit the contents of a report to specific hours of
the day and specific days of the week.

Using Report Contexts for Multiple Reports

Reporting Center allows you to configure a context and use that setting in other reports that contain
the same context. The value of a Pinned context overrides the default value of the context in other
reports. The value of a context that is Not Pinned is used only in the report displayed.

For example, you can pin the Date Range value of the Time context to Last Month if you want to
execute a number of different reports, but only display data from the past month for each report. You
can also execute reports that retrieve data for the same servers and metrics, but for a number of
different time periods, by pinning other contexts.
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When you open a report that does not contain the same context as the one that is pinned, Reporting
Center automatically unpins the context for those reports, but keeps it pinned when you switch to a
report that contains the context.

To use a context value in multiple reports:

1 In the Tasks pane, click the Report Context tab.
2 Click the name of the context at the bottom of the Context pane.

3 Click Not Pinned at the top of the Context pane, which changes the button to Pinned, and pins
that context. When you open another report containing the same context, the Reporting Console
displays the pinned value.

Report Properties

Report properties in Reporting Center describe the report (such as name, description, date modified)
and specify the appearance of the report (chart type, data series properties, 3-dimensional
properties, and so on). You can modify most properties to customize your report.

Each time you modify a property, click Apply to view the changes. When you are done with modifying
the report properties, save the report. Before you deploy the reports, experiment with the chart
properties to ensure that you are presenting information in the best way for your intended audience.
As you design your reports, keep in mind that certain properties in the Reporting Console are not
supported by SSRS. For more information, see Section 4.5.1, “SSRS Limitations,” on page 33.

If the report is already deployed to SSRS, saving the report in the Console redeploys the report to all
SSRS locations. Therefore, if you want to experiment with the appearance of a report, but do not
want the report to be redeployed each time, save a test version of the report that you can use to
configure in different ways.

Example: Configuring Axes to Enhance Charts

Reporting Center makes it easy to configure chart properties to create interesting and relevant
reports. Suppose you are preparing a report that contains data over a period of 20 months. In this
report, you have a Column chart type, and the maximum value for the Y-axis is set to 100. You can
use properties to manipulate the way the chart represents the data. For example, if you use the
default settings for Automatic Minimum Axis Value and Automatic Maximum Axis Value (in the
Report Properties dialog box, go to Axes > Primary Y-Axis > Configure), Reporting Center calculates
the minimum and maximum values for the Y-axis based on the minimum and maximum values of the
data in the report.

Although the chart provides an accurate representation of the values, you can use the Y-Axis
properties to provide a more meaningful presentation of this information. You can set the Y-axis to
match the possible range of values by configuring Minimum Axis Value and Maximum Axis Value,
which will provide you with a visual representation of where your data fits into the larger scheme.

To make the chart even more readable, you can limit the number of labels on the X-axis. For
example, it is unnecessary to display a date on each data point for 20 months. You can change the
frequency of the X-axis labels by changing the Label Interval Type to Auto or by changing it to Data
Point, and specifying a number larger than 1 (in the Report Properties dialog box, go to Axes > X-
Axis > Configure).

This is just one example of the ways that you can use properties to clarify the information in your
charts and make them easier to understand.

For more information about setting the report properties, Section 5.3, “Setting the Properties For a
Report,” on page 41.
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4.2

Chart Limitations

When you configure properties for charts, consider the following information:

+ If you use scale breaks in your charts, NetlQ Corporation recommends using the default settings

provided in the Reporting Console. Microsoft Chart Controls have a limitation in which scale
breaks are not supported in the following conditions:

+ Pie, doughnut, or any stacked chart types are used.

¢ Custom intervals for labels, tick marks or grid lines are enabled.

¢ The minimum or maximum value for the axis is set.

¢ Custom labels are used.

+ Alogarithmic Y-axis is specified.

+ Axis views on the Y-axis, which include scrolling and zooming, are used.

¢ 3-D charts are used.
If any of these conditions are used with scale breaks, the Reporting Console stops working. For
more information about this issue, see Microsoft Website.

If you choose any of the Line chart types, specifically Line; Fast Line; Step Line; and Spline, use
the Border Line Width and Border Line Style properties to configure the appearance of the data
series. This ensures that these charts are displayed correctly when deployed to SSRS. You
access these settings in the Report Properties window on the Data Series tab.

Note that, for these chart types, you do not use the Border Line Color option to set the data
series color. Instead, you use the Color property in the Configure Data Series dialog box, which
you access from the Data Series tab by clicking Configure on the Predefined Data Series or
Custom Data Series fields. Click the Chart tab and set a value for the Color field.

If you specify a column for the X-axis that is in date-time format, you cannot group the data by
that column, or sort the data in ascending or descending order. For all other data types, the
grouping and sorting options are available.

Exporting Report Definitions

You can share reports by exporting report definitions. Reporting Center allows you to email or export
charts and tables in a number of image and file formats. To export report definitions of a report, select
the report in the Navigation pane, then click Report > Export Report Definition.

Using Linked Reports

You can link a report to one or multiple reports. To link a report named r epor t 1 to another report
named r eport 2, you must add r epor t 2 as a related report of report 1.

To add related report:

1 Select the report to which you want to add the related report.
2 Click Report Properties > Related Reports.

3 Click Add New and select the report to add.

4 Click OK twice.

In Reporting Console, the related reports for this report are listed in Tasks > Related Reports.
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You can use the Drill-Down templates to create drill-down reports. To make effective use of this drill-
through capability, you must configure the linked reports ahead of time. For example, you might have
a report that illustrates HTTP requests for the past year aggregated by month. You can create links
from each monthly value to a report that provides the daily values for that month. You can also link
from the daily values to reports that provides hourly values. For more information about Drill-Down
templates, see “Drill-Down Templates” on page 24.

To link Drill-Down reports:

1 Run the parent report that you want to link.

2 In the Table view, right-click the Machine header and then click Data Series Properties >
General.

3 In the Linked SubReport panel, click Choose Subreport.
4 Select a linkable report.
5 Click OK twice.

If you want to deploy a report that contains links to other report, you need to first deploy the other
report. For example, if Report A contains a link to Report B, first deploy Report B and then Report A.

Using Dashboard Reports

Dashboard reports provide a way of grouping reports that contain related data in a single layout.
Often, the purpose of a dashboard report is to give an overall picture of a specific part of your
business. Accordingly, when you configure the dashboard, you should limit the amount of information
displayed for each member report to make it more readable.

To create a new dashboard report:

+ Right-click the Reports folder, click New > Dashboard and add the member reports.

+ Save an existing dashboard report with a new name and then add or delete the member reports
as required.

Dashboard Presentation

When you design the layout of a dashboard, consider the amount of information you want to present
for each report on the page. To present only the most useful information for each report, Reporting
Center provides the Data Record Limit setting, which allows you to determine the number of rows to
display so that the dashboard is readable.

When you open a dashboard report, the Reporting Console displays the chart or table containing the
limited number of data records. In the Reporting Console, you can use a scroll bar to view rows that
did not fit into the page layout you chose, or you can click the title of the report to view all data
records.

When you view a deployed report in a Web browser, SSRS does not provide a scroll bar, so it
displays only the number of rows that fit onto the page size you chose in the Deploy Report wizard.
Because additional rows are truncated by SSRS, use the Data Record Limit setting in the Console to
ensure that the member reports of the dashboard are displayed correctly. In SSRS, if you want to
view the complete report, first ensure that the member report is deployed, and then click the title of
the member report.

Working with Reports 31



4.3.2

32

4.4

Because member reports are embedded in dashboard reports rather than linked, if you modify and

redeploy a report that is also in a dashboard, you must also redeploy the dashboard report. You can
also deploy a dashboard without deploying individual member reports. In such cases, you can view
the deployed dashboard, but cannot click the report title to view the complete report.

Shared Contexts

In a dashboard report, you can create shared dashboard contexts by using the existing contexts from
member reports and overriding the default context values. Changing a report context to a shared
dashboard context does not modify the value of context in the original report. Shared contexts just
provide flexibility for the way you configure the dashboard. Instead of changing contexts in several
individual reports and then adding them to the dashboard, you just override the default context values
of the existing member reports. Member reports can use a combination of shared dashboard contexts
and default report contexts.

When you create a dashboard, the Reporting Console displays the contexts found in the member
reports. Often, more than one report contains the same context type, such as Time or Data Source
Connection, with different values.

You can share these contexts to have all reports use them. For example, the same time period or
retrieve data from the same database. In these cases, the Reporting Console displays the default
values of the context from one of the reports and allows you to customize the context values for the
dashboard. For example, if the member reports of your dashboard display data for a number of
different time periods, and you want them all to show data for the last 14 days, share the Time context
so that it overrides the default values for each report. Or, if you have two reports that retrieve data
from two different databases, you can override contexts so that both reports retrieve data from the
same database.

NOTE: You can configure Contexts only in the Reporting Console and not in SSRS.

Migrating Reports
You can migrate reports from Analysis Center Console to Reporting Center Server.

To migrate reports, do one of the following:

+ After upgrading from Analysis Center 2.9 to Analysis Center 3.2 on the same computer:

1. Use the Report Migration utility from the Analysis Center Admin Console to migrate the
report. For more information, see “Migrating the Reports to Reporting Center” in the NetlQ
Analysis Center Administrator Guide.

+ From an Analysis Center 2.9 computer to an Analysis Center 3.2 computer:

1. On the Analysis Center 2.9 setup, apply either the Analysis Center 2.9 Hotfix 7015655 or
the Analysis Center Hotfix 2.9.0.3 and then use the Analysis Center Console to export the
reports.

NOTE: If the Analysis Center Hotfix 2.9.0.3 is already installed, then you do not need to
apply the Analysis Center 2.9 Hotfix 7015655.

2. On the Analysis Center 3.2 setup, use the Report Migration utility from the Analysis Center
Admin Console to migrate the reports exported from Analysis Center 2.9. For more
information, see “Migrating the Reports to Reporting Center” in the NetlQ Analysis Center
Administrator Guide.

Working with Reports


https://dl.netiq.com/Download?buildid=Sk8EdfDit4k%7E
https://www.netiq.com/documentation/analysis-center/pdfdoc/ACAdminGuide/ACAdminGuide.pdf#t432t5jczwbs
https://www.netiq.com/documentation/analysis-center/pdfdoc/ACAdminGuide/ACAdminGuide.pdf#front
https://www.netiq.com/documentation/analysis-center/pdfdoc/ACAdminGuide/ACAdminGuide.pdf#front
https://www.netiq.com/documentation/analysis-center/pdfdoc/ACAdminGuide/ACAdminGuide.pdf#t432t5jczwbs
https://www.netiq.com/documentation/analysis-center/pdfdoc/ACAdminGuide/ACAdminGuide.pdf#front
https://www.netiq.com/documentation/analysis-center/pdfdoc/ACAdminGuide/ACAdminGuide.pdf#front
https://dl.netiq.com/Download?buildid=_oL6Y54b4F4~
https://dl.netiq.com/Download?buildid=_oL6Y54b4F4~
https://dl.netiq.com/Download?buildid=Sk8EdfDit4k%7E

4.5

45.1

452

Deploying Reports

You deploy reports to SSRS to make them accessible to anyone using a Web browser. Reporting
Center allows you to configure SSRS directly from the Reporting Console. You can deploy either a
single report or multiple reports simultaneously to SSRS. When a single report is deployed, you can
perform a number of deployment options, such as running the report on a schedule, delivering
deployed reports to a file share or an email address. The reports automatically refresh when data
changes.

After you deploy a report, Reporting Center automatically deploys changes when you save or run the
report in the Console. It is not necessary to manually redeploy a report each time you modify it in the
Console, unless you set up a subscription for the report. In that case, when you modify the report in
the Console, you must redeploy the report once to reset the subscription. If you delete a deployed
report from the Console, it is also deleted from SSRS.

NOTE: To deploy reports from Reporting Center, you must have permission to deploy a report from
the Console and you must configure the correct permissions in SSRS. In addition, to take advantage
of the email delivery option, you must configure email settings in SSRS.

SSRS Limitations

Before you deploy reports to SSRS, consider the following:

+ For reports deployed using Microsoft SQL Server 2008 Reporting Services, the deployed report
does not display the grid lines and tick marks configured in the Reporting Console. You configure
grid lines and tick marks in the Properties dialog boxes for the X-Axis, Primary Y-Axis, and
Secondary Y-Axis.

¢+ SSRS does not support the Forecast report property. Consequently, reports configured in
Reporting Center using Forecast does not display the forecasted data series.

+ SSRS does not support the Data Point Marker Step report property. When you configure a data
point step for markers on a data series, the value of the step is always 1 in SSRS, regardless of
the actual value you set the Reporting Console before deploying the report. For more
information, see Report Definition Language.

+ If you configure the report in the Deploy Report wizard to automatically refresh at regular
intervals and modify the report in the Console, then the following error is displayed when SSRS
refreshes the report:

An error occurred during client rendering. An error has occurred during report
processi ng. The data source ‘DataSourceName’ cannot be found.

To refresh the report, click F5 in the browser. SSRS resumes the auto-refresh at the intervals
specified in the Deploy Report wizard.

Deploying a Report to SSRS

After you have saved a report, you can deploy it to SSRS.

To deploy areport to SSRS and view the deployed report:

1 From the Reports tab, click Deployment > Deploy Report.

2 Enter information in the Deploy Report wizard. For more information about the wizard, see the
Help.

3 Click Finish.

Working with Reports 33


http://schemas.microsoft.com/sqlserver/reporting/2008/01/reportdefinition

4 To view the deployed report, go to a Web browser and type one of the following URL as
applicable:

¢ http://ServerNane/ Report Server
¢ http://ServerNane/ Report Server _i nst ance
5 Click the deployed report.

453 Deploying multiple Reports to SSRS

You can select multiple reports simultaneously and deploy it to SSRS.
To deploy multiple reports:

1 From the Quick Access Tool bar, click Deploy Bulk Reports.
2 In the Bulk Report Deployment, select the required reports.

3 Select the SQL Server Reporting Services URL. If you want to validate the URL that you have
selected, click Validate. To add a new URL of a SQL Server Reporting Server, click
AddNewLocation.

4 Click Deploy Selected.

454 Using Report Designer to Edit RDL Files

To customize reports, you can also use Report Designer to edit the Report Definition Language (RDL)
files for reports you have deployed to SQL Reporting Services. A thorough working knowledge of
Report Designer is necessary for making this sort of modification to a report. For more information
about using Report Designer, see the Reporting Services Books Online and Microsoft Visual Studio
.NET Documentation.
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Customizing Reports

This chapter provides information on how to set the report contexts and properties so that you can
generate reports with the information presented in the required format.

+ Section 5.1, “Using the Report Options,” on page 35
+ Section 5.2, “Setting the Context For a Report,” on page 37

*

Section 5.3, “Setting the Properties For a Report,” on page 41
+ Section 5.4, “Making Readable Charts,” on page 48

*

Section 5.5, “Exporting and Printing Charts and Tables,” on page 50

Using the Report Options

To display the Reports tab in the top Navigation pane of Reporting Console, select a report in the left
Navigation pane. The Reports tab displays the following options:

Option Description
Properties
Report Properties Displays the properties that you can set for the report. For more

information about setting the report properties, see Section 5.3,
“Setting the Properties For a Report,” on page 41.

Report Permissions Allows the administrator to view and configure permissions for a
user group.

For objects in a hierarchy, the most restrictive permissions apply to
the subfolders and objects. If the administrator has not configured
security for a particular object, the object inherits the permissions of
its immediate parent. When you log on to Reporting Console, it
displays only the objects that you have permission to view.

Report Contexts Displays the contexts that you can set for the report. For more
information about setting the report contexts, see Section 5.2,
“Setting the Context For a Report,” on page 37.

View
Initial Display Options Allows you to choose the action to perform when a report is
launched:
+ Always Run a New Report: Runs a new report.
+ Show Last Cached Report if Exists: Runs the last cached
report if it is available.
For AppManager Templates, these options are not displayed.
View Type Allows you to choose if you want to display the report data in a

table, chart, or both, if applicable to that report.
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Option Description

Data Presentation Type Allows you to determine how a report presents its data. The two
states of data presentation include:

+ Standard: Presents the report in the default view. You can
only change the data series displayed on the X-axis.
¢ Cross Bound: Allows you manipulate the presentation to
create multiple views of the same data.

Action

Save Report Allows you to save the changes you made in a report. Saving a
report also automatically redeploys report that you previously
deployed to SSRS, so you do not have to manually redeploy reports
after you modify them in the console, unless you set up a
subscription for the report.
If a report is set as a Base Report, you cannot save the changes
made to this report. However, you can save the modifications made
to the Base report by using Save Report As option.

Save Report As Allows you to save a report with a different name.

Validate Report Contexts Allows you to validate the contexts of the report.

Run Report Allows you to run the report.

Export Report Definition Allows you to export the report definition to a XML file.

Deployment Allows you to deploy the report to SSRS so that the report can be
accessed using a web browser.

Print/Export/Email Allows you to print, export, or email reports. For more information,
see Section 5.5, “Exporting and Printing Charts and Tables,” on
page 50.

Chart

Chart Type Select the graphical style of the chart, such as Area or Bar.
For information about the limitations associated with different types
of charts, see Section 4.1.3, “Chart Limitations,” on page 30.
If you change the chart type after you have created a report, you
must click the Run Report option to update the changes. If you do
not run the report after making changes, the chart legends might be
incorrect.

Show Chart Title Toggles between displaying or hiding the chart title.

Show Chart Legend Toggles between displaying or hiding the chart legend.

Show Data Point Labels Toggles between displaying or hiding the data point labels.

Show 3-Dimensional Charts Toggles the chart display between 2D and 3D views.

To move a report or report folder, drag and drop the report or report folder to required location.
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5.2.1

The following options are displayed when you right-click a report in the navigation tree:

Option Description
Rename Allows you to rename a report.
Delete Allows you to delete a report. You cannot delete a base report.

Setting the Context For a Report

The context of a report refers to the machines, data streams, and time frame that are the subject of
the report. It might also include measures of the data, such as average or maximum.

NOTE: Depending on the amount of data called for by your context settings, the time required to run
a query might exceed the timeout settings in the Wb. confi g file, causing the query to abort. If you
are routinely generating reports that contain large data sets, you can alter the timeout settings by
editing the Web.config file. For more information about the timeout issues and the workaround, see
“Report Timeout Issues” on page 61.

¢ Section 5.2.1, “Using the Multi-State Tree Control,” on page 37

+ Section 5.2.2, “Selecting Report Data,” on page 38

+ Section 5.2.3, “Setting the Group Context,” on page 38

+ Section 5.2.4, “Setting the Knowledge Script Context,” on page 38
¢ Section 5.2.5, “Setting the Measures Context,” on page 38

+ Section 5.2.6, “Setting the Metric Context,” on page 39

+ Section 5.2.7, “Setting the Time Context,” on page 39

Using the Multi-State Tree Control

The contexts use a multi-state tree control that lets you create different orientations of the data based
on your selections. The capability to make different types of selections from different levels of the tree
view gives you flexibility in how you present data in a report. For example, you can compare the

average memory use of an individual SQL Server with the average memory use for all SQL Servers.

To explicitly select a folder, click the checkbox next to the folder one time. To deselect the folder and
select each of its immediate children, click the same checkbox again. To deselect the folder and all of
its subfolders, click the checkbox a third time.

Selection State Description

O Neither the parent nor its children are selected.

Ol The parent is selected, but none of its children are selected.

[ The parent is not selected, but one or more of its children are selected.
m The parent is selected and one or more of its children are selected.
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5.2.2

5.2.3

5.2.4

5.2.5

Selecting Report Data

The Data Source context lets you select which Data Sources you want to use for an AppManager
report. By default, AppManager reports reflect all Data Sources. Use the tree control to select the
Data Sources to report on.

Setting the Group Context

The Group context allows you to select individual servers, groups of servers, or server instances to
be included in a report.

When you select an AppManager report, a View menu at the top of the Group context control lists the
views from the various AppManager repositories from which you want to display data.

To set the Group context:

1 Select a view to display all the servers in that view.

If there is more than one instance of a view among the various AppManager repositories (for
example, IIS or NT), then all servers from all instances of that view are displayed.

The Master view might contain other server groups.

2 Select Show Instances if you want to list server instances, such as SQL Server instances, in the
tree control.

Setting the Knowledge Script Context

The Knowledge Script context lets you filter the report data by Knowledge Script. Use the tree control
to select the individual Knowledge Scripts or groups of Knowledge Scripts whose data you want for
your report.

Setting the Measures Context

The Measures context lets you calculate statistics from the data in the report. Use the tree control to
select the measures in which you are interested.

Depending on the report, you can select one or more of the following measures. For the Measures
context, the tree control provides only two selection states: Selected and Not Selected.

+ Average: Average of data point values within the selected date range.

Average = aggregate sum/ aggregate count
+ Count: Number of data points collected by a data stream/legend within the selected date range.
+ Maximum: Highest number of all the collected data point values within the selected date range.
+ Minimum: Lowest number of all the collected data point values within the selected date range.

+ Standard Deviation: Value that indicates how tightly a set of values is clustered around the
average of those same values (square root of the product).
[((SunOF Squares - (Sum* Sum/ Count)) / (Count-1))]

+ Sum: Total of all collected data point values within the selected date range.
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5.2.6

5.2.7

Setting the Metric Context

The Metric context lets you select the data for an AppManager report. You can filter your selections
by metric type. The metrics are grouped by applications. For example, NT folder lists all NT related
metrics.

If you select too many data streams for a report, the chart might become unreadable.

In the reports or the charts, Analysis Center does not display metrics for which the data is empty and
does not display machines for which data does not exist.

To set the Metric context:

1 Select the required Metric Type.

You use the Metric Types list to limit data to specific types of data streams. For example,
AppManager performance data or AppManager event data.

2 Use the tree control to select the metric. You can select a single data stream, or multiple
individual data streams, or groups of data streams from various levels of the hierarchy.

Setting the Time Context

The Time context lets you specify a time frame for your report.

Some reports include multiple Time context controls, which allow you to compare the same type of
data over different periods of time. For example, the processing time required for SQL statements
over the past 12 months when compared to the last 28 days.

The time range filters are Interval, Start Time, End Time, Days Of Week, and UTC. For reports that
allow you to specify multiple time ranges, the time range filters are set in the first control and ignored
in the other time controls to enforce a comparison of similar type of data.

For example, if the Time control specifies hourly intervals for data collected Monday through Friday,
then these filters do not apply to all time ranges covered in the report only for the first one.

Setting the Date Range

The Time context control lets you set a custom time range or select from a number of predefined time
ranges:

Date Range Time Represented

Last 7 Days The last seven days.

For example: If today is January 7, then the last seven days are January 1 to January
7.

Last 12 Months The previous twelve months.

For example: If today is any day in January, 2005, then the previous 12 months are
January 1, 2004 to December 31, 2004.

Last 28 Days The last twenty-eight days.

For example: If today is January 28, then the last 28 days are January 1 to January 28.
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Date Range

Time Represented

Last 3 Months

The previous three months.

For example: If today is any day in April, then the previous three months are January 1
to March 31.

Last 365 Days

The last 365 days.

For example: If today is December 31, 2005, then the last 365 days are January 1,
2005 to December 31, 2005.

Last 4 Quarters

The previous four quarters.

For example: if today is January 1, 2005, then the previous four quarters are January
1, 2004 to December 31, 2004.

Last 6 Months

The previous six months.

For example: If today is January 1, 2005, then the previous six months are July 1, 2004
to December 31, 2004.

Last 90 Days

The last 90 days.

For example: If today is December 31, then the last 90 days are October 3 to
December 31.

Last Month The previous month.
For example: If today is any day in February, then the previous month is January 1 to
January 31.

Last N Days The previous N days. The value of N ranges from 2 to 31.

The Date Range sets the base time as the day on which the report is run and counts
back N days from the base time.

For example: If you select N Value as 2 and if today is July 26, 2007, then Analysis
Center generates a report for the date range, 7/25/2007 to 7/26/2007.

Last N Months

The previous N months. The value of N ranges from 2 to 12.

For example: If you select N Value as 5 and if the current month is July, then Analysis
Center generates a report for the date range, 2/1/2007 to 6/30/2007.

Last N Weeks

The previous N weeks. The value of N ranges from 2 to 12.

For example: If you select N Value as 2 and if today is August 16, 2007, then Analysis
Center generates a report for the date range, 7/29/2007 to 08/11/2007.

Last Quarter

The previous quarter.

For example: if today is any day in April, then the previous quarter is January 1 to
March 31.

Last Week The previous week (Sunday to Saturday).

Last Year The previous year.
For example: If today is any day in 2005, then last year is January 1, 2004 to
December 31, 2004.

This Month All days in the current month.

For example: If today is January 15, then this month is January 1 to January 31.
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Date Range Time Represented

This Quarter All days in the current quarter.

For example: if today is February 15, then this quarter is January 1 to March 31.

Today 12:00:00 AM to 11:59:59 PM of the current day.
Yesterday 12:00:00 AM to 11:59:59 PM of the previous day.
Custom Range The specified date range.

For example, you can select Start Date as 7/23/2007, End Date as 7/26/2007 to
generate a report.

Selecting a Time Interval

From the Time Interval option, select the time interval at which you want data to be aggregated in the
report. For example:

+ For a date range of 12 months, you might want to aggregate data by month rather than day.
+ For a date range of seven days, it might be more appropriate to aggregate data by day.

Selecting a Start Time and End Time

To limit the contents of your report to specific hours of the day, set the desired time in the Start Time
and End Time options. For example, if you are interested primarily in the level of message traffic on

your Exchange Servers during regular working hours, you can limit the contents of the report to data
collected between 8:00 AM and 6:00 PM.

Selecting Days of the Week

You can limit the contents of your report to specific days of the week or all days. For example, if you
are interested primarily in the level of message traffic on your Exchange Servers during regular
working days, you can limit the contents of the report to data collected from Monday to Friday.

Selecting UTC Time

Data is represented using local time by default. Local time is appropriate when the resources in
question are specific to a time zone. For example, a file or application server used for a particular
office or region.

Select UTC to present data according to Universal Time Coordinated (UTC) time. UTC time is
appropriate for resources that are accessed from multiple time zones. For example, Web or database
servers.

Setting the Properties For a Report

The Report > Report Properties tab displays the various report properties that you can set based on
your requirements. This tab is available only when you select a report in the Navigation pane.
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Property

Description

Report Name

Displays the name of the report. This is a read-only option.

To edit the report name, select the report in the tree view and click
Rename.

Base Report

Specifies if other reports are referring to this report or not. If this
option is checked, then this report is a base report and has other
reports referring to it. This is a read-only option.

Description Allows you to specify a brief description for the report. This
description is displayed beneath the report title in the Results pane.
Comments Allows you to specify the text that you want to associate with the

report.

Last Modified

Displays the last time when the report was modified in the database.
This is a read-only option.

Last Modified By

Displays the name of the last person who saved the report. This is a
read-only option.

View Type

Allows you to choose to display the data in a table, chart, or both, if
applicable to that report.

Internal Report ID

Displays a string identifier that is internally used. This is a read-only
option.

Initial Display Options

Allows you to choose the action to perform when a report is
launched:

+ Always Run a New Report: Runs a new report.

¢ Show Last Cached Report if Exists: Runs the last cached
report if it is available.

For AppManager Templates, these options are not displayed.
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5.3.2

5.3.3

5.3.4

Chart Properties

Property

Description

Chart Type

Select the graphical style of the chart, such as Bar, Column, or Pie.

(Conditional) If you select a chart type such as Column or Bar, then
Column/Bar Chart Drawing Style is enabled.

(Conditional) If you select a chart type such as Pie or Doughtnut,
then Pie/Doughnut Chart Drawing Style is enabled.

For information about the limitations associated with different types
of charts, see Section 4.1.3, “Chart Limitations,” on page 30.

If you change the chart type after you have created a report, you
must click the Run Report option to update the changes. If you do
not run the report after making changes, the chart legends might be
incorrect.

Column/Bar Chart Drawing Style

Allows you to specify a drawing style for the Column or Bar chart
type you selected. The default option is Cylinder.

Pie/Doughnut Chart Drawing Style

Allows you to specify a drawing style for the Pie or Doughnut chart
type you selected. The default option is Soft edge.

Pie/Doughnut Properties

Reporting Center displays the Pie/Doughnut tab only if you selected the chart type as Pie or

Doughnut.

Property

Description

Data Series Name

Specify the data series column for which you want to draw the chart.

Label Position Style

Specify if you want to place the label inside the slices or outside of
the slices.

Doughnut Radius

Specify the radius of the doughnut portion in the Doughnut chart.

First Slice Start Angle

Specify the starting angle for the first slice of pie charts or for the
given series.

Collect Small Slices

Select this option to specify the Collected Slice Properties. These
properties allows you to display data streams that are smaller than a
specified size as one slice. To separate this slice from the pie or
doughnut, click Show Collected Slice as Exploded.

Data Series Properties

This window allows you to customize the display of all the data series in a report. Columns in a table
represent individual data series. You can configure individual data series and override these global
settings, or create new data series based on existing ones.

Customizing Reports

43



44

Property

Description

Border

If you choose any of the Line Chart Types (Line, Fast Line, Step
Line, and Spline), use the Border Line Width and Border Line
Style properties to configure the appearance of the data series.
This will ensure that these charts are displayed correctly when
deployed to SSRS. To set the color of the data series lines, do not
use the Border Line Color option. Instead, use Predefined Data
Series or Custom Data Series, then click Configure or New and
click the Chart tab. Set a value for the Color option.

Empty Point Value Appearance Type

When you configure the appearance of empty points for reports that
display trending data, None leaves a space between the two known
values, Zero assigns a zero value to the missing data values, and
Average calculates the average values and connects two known
values. Use the Average setting to represent the overall trend, even
when there is an interruption to the data collection. For example,
when the gap is caused during routine server maintenance.

Data Marker

Specify the visual indicator to draw attention for each data pointin a
series.

SSRS does not support the Data Point Marker Step property. When
you configure a data point step for markers on a data series, the
value of the step is always 1 in SSRS, regardless of the actual value
you set the Reporting Console before deploying the report. For
more information, see Report Definition Language (RDL) 2008
(http://schemas.microsoft.com/sqlserver/reporting/2008/01/
reportdefinition).

Sort order

Specify Ascending or Descending to order data series
alphabetically in the table. Custom allows you to drag the columns
to customize the order. This allows you to make the most important
columns visible if the report query places them after less important
data.
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5.3.5

5.3.6

Property Description

Predefined Data Series You can configure the properties for a predefined Data Series. For
example:

+ Change the format of the Data Series value to make it
readable: Consider that the Data Series value displayed by
default is 732.080815534973. You can change the format to
display the value in a more readable format. For example:

* Number: The Data Series value is displayed as 732.

+ Scientific: The Data Series value is displayed as
7.321E+002.

+ Currency: The Data Series value is displayed as
$732.08.

+ Custom: If you specify the Customized Format as F3,
the Data Series value is displayed a 732.081.

¢ Shift the display of the Data Series from Primary Y-Axis to
Secondary Y-axis: Do the following

1. Click Report Properties > Data Series.

2. In the Predefined Data Series pane, select the series
name and click Configure.

3. In the Configure Predefined Data Series window, click
Chart.

4. In the Y-Axis Affinity pane, select Secondary Y-Axis.
5. Click OK twice.

¢ Link Drill-Down reports: For more information about linking
Drill-Down reports, see Section 4.2, “Using Linked Reports,”
on page 30.

Custom Data Series Create new data series based on existing ones. You can set one
data series as the standard, against which you compare other data
series. For example, if you have a Stacked Column chart type, you
can configure the standard data series with the Line chart type in
order to compare the other data series to it. By configuring one data
series in a report differently than the others, you obtain a contrasting
visual presentation of a particular category or value. You can also
create a new column based on an existing one, modify it to
manipulate the data a particular way, and then layer the new column
over your chart for easy reference.

Axes Properties

This window allows you to customize the display of labels, text, colors, and cursors on the X- and Y-
axes. Clicking Configure for a specific axis displays properties specific to that axis. The primary Y-
axis is always displayed on the left side of the chart, and the secondary Y-axis on the right. In the
table, the column name of the secondary Y-axis is italicized.

Title Properties

This window allows you to configure the display of the chart title. You can place the title in a number
of positions on the report using different fonts and text effects. For the title color, the default is to use
the current skin to keep it consistent with the rest of chart.
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Property Description

Docking Select the placement of the title relative to the chart. This property is
used in conjunction with the Alignment property. The default option
is Top.

Orientation Select the orientation of title. The default option is Auto that allows

Reporting Center to choose the best suited orientation.

Alignment Select the placement of the title relative to the Docking property
value.
Color Select the color for the title. By default, the Use Current Skin option

is selected to keep the title color consistent with the rest of chart.

Font Select the font in which you want to display the title.
Text Style Select the style such as shadow or emboss in which you want to
display the title.

5.3.7 Legend Properties

This window allows you to configure the display of the chart legend. You can place the legend in a
number of positions on the report, using different fonts and colors. To experiment with the legend
settings, choose the settings and click Apply. This allows you to view the changes in the report
without closing the Report Properties window and without saving changes.

Property Description

Style Select Column, Row, or Table to specify how the legend text is
ordered.

Docking Select the placement of the legend relative to the chart. This
property is used in conjunction with the Alignment property.

Alignment Select the placement of the legend relative to the Docking property
value.

Border Select the appropriate values for the border line width, style, and
color.

Text Color Select the color for the legend text. By default, the Use Current

Skin option is selected to keep the legend text color consistent with
the rest of chart.

Font Select the font in which you want to display the legend.

Auto Fit Text Resizes the chart and the legend according to the Docking and
Alignment settings you configured. This option is selected by
default.

5.3.8 Label Properties

This window allows you to configure the labels on data points in a chart. As you configure these
settings, use the Apply button to view the changes to the labels without closing the Report Properties
window and without saving the changes. You might need to experiment with the position and
properties of the data point labels and callouts in order to create the most useful, readable chart.
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5.3.9

5.3.10

5.3.11

5.3.12

3-Dimensional Properties

This window allows you to customize the display of three-dimensional charts. You can rotate the chart
by setting the values in this window or by using your mouse or keyboard. When you use your mouse
or keyboard, Reporting Center updates this window with the exact angles of the chart.

Property Description
Light Style Select the style in which the 3D chart components are shaded.
Horizontal Axes Rotation Angle Determines the rotation (-180 to 180) of the chart around its X-axis.

A positive value rotates the chart in a counterclockwise direction.

Vertical Axes Rotation Angle Determines the rotation (-90 to 90) of the chart around its Y-axis. A
positive value rotates the chart in a clockwise direction.

Perspective (Percent) Specify a numerical value (from 0 to 100) that represents the
perspective of the chart. The higher the value, the greater the angle
of perspective (background to foreground).

Isometric Projection Specifies whether the X-axis and Y-axis are rendered at right
angles. When you select this, it overrides the Perspective property.

Point Depth Specify a numerical value (from 0 to 1000) that represents the depth
of chart of the Z axis. Applies to bar, column, line, pie, and spline
charts.

Threshold Properties

This window allows you to configure thresholds for a report, which graphically represent values that
exceed or fall below a specified value, or are between two specified values. Reporting Center
displays thresholds in the color you select. For example, you can visually track sales figures that rise
above a certain threshold, or track the CPU usage of under-performing servers. Ensure that you
enable this property to configure it.

You can display the threshold color on both the chart and table, or on either one. Both the Reporting
Console and SQL Server Reporting Services displays the threshold as you configure it in this window.
Threshold values are based on the primary or secondary Y-axes. You set threshold values for one Y-
axis at a time, since primary and secondary Y-axes have different scales.

Choosing a Custom threshold type allows you to build an expression that displays more complex
threshold conditions that can include threshold values for more than one data series. For example:
[data series 1 name] > 190 AND [data series 2 hame] < 210

Data Record Limit
This window allows you to determine the number of rows Reporting Center displays in a report. Using
this property, you can make the report more readable, and include only the information your audience

needs. This is especially useful when creating dashboard reports, in which you want to present a
snapshot of the data.

Related Reports

This window allows you to create a list of linked reports for a report. When you run the report, you can
view the list of its related reports in Tasks > Related Reports tab.
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5.4 Making Readable Charts

You must present the information in charts such that it is easily understood. Presenting the
information clearly in a chart depends on how you set the properties for the chart. Before you save or
deploy the report, experiment with the chart properties to ensure that you present the chart
information in the best possible way for the intended audience.

Consider that you want to prepare an average memory usage over the past four weeks report, with
data based on percentage values. If you retain the default settings for Automatic Minimum Axis
Value and Automatic Maximum Axis Value options in the Primary Y-Axis Properties window (Report
Properties > Axes > Primary Y-Axis Configure), then a chart similar to the following is displayed.

Average Memory Utilization by Server Crver Time

2 Al Machines

The maximum value for the Y-axis is calculated based upon the maximum value in the report. The
above chart provides an accurate representation of the values. However, to provide a more
meaningful context in which the information is presented, do the following to set the Y-axis of the grid
to match the possible range of values (0% to 100%).
1 Click Report Properties > Axes.
2 In the Primary Y-Axis pane, select Enabled and click Configure.
3 In the Primary Y-Axis Properties window, do the following:
3a Deselect the Automatic Minimum Axis Value and Automatic Maximum Axis Value options.
3b Set the Minimum Axis Value as 0.
3c Set the Maximum Axis Value as 100.
3d Click OK.
4 Click OK.

The new Chart displays as follows and provides more easy and meaningful information about what
percent of the maximum is being utilized.
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To further enhance the clarity of the chart, you can edit the chart properties to limit the number of X-
axis labels. In such a report, it might not be required that each date of the last four weeks is displayed.

You can choose to display every seventh date:

1 Click Report Properties > Axes.
2 In the X-Axis pane, select Enabled and click Configure.
3 In the General tab, do the following:
3a Setthe Label Interval Type to Data Point.
3b Setthe Label Interval to 7.
3c Click OK.
4 Click OK.

The new chart with every seventh date displayed:

Average Memory Utilization by Server QOwver Time
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If the labels are especially long, you can set the report properties to wrap the label:

1 Click Report Properties > Axes.
2 In the X-Axis pane, select Enabled and click Configure.
3 In the X-Axis Properties window, do the following:
3a Click the Labels tab.
3b Select the Auto Fit option.
3c In the Auto Fit Options, select Can Wrap.
3d Click OK.
4 Click OK.

5.5 Exporting and Printing Charts and Tables

You can export and email the report chart and table in a variety of formats.
To export, print, or email a chart:

1 In the Reporting Console, click the Reports tab.

2 Click Print/Export/Email on the top navigation pane.
3 Click Chart.

4 (Conditional) To print the chart, Click Print.

5 (Conditional) To export the chart, click Export To and select the format in which you want to
export, and then click OK.

6 (Conditional) To email the chart, click E-Mail As and select the format in which you want to email,
and then click OK.
To export, print, or email a table:

In the Reporting Console, click the Reports tab.
Click Print/Export/Email on the top navigation pane.
Click All Table Records or Selected Table Records.
(Conditional) To print the records, Click Print.

(Conditional) To export the records, click Export To and select the format in which you want to
export, and then click OK.

6 (Conditional) To email the records, click E-Mail As and select the format in which you want to
email, and then click OK.
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A Troubleshooting

This section provides solutions to the issues you might encounter when using Analysis Center:

*

*

*

“Error When Selecting a Data Source” on page 52
“Report Data Mismatch in SQL Server Reporting Services and Reporting Console” on page 52

“Reporting Center Does Not Support Windows Accounts That Contain Japanese Characters” on
page 52

“Reporting Center Does Not Retrieve Japanese Characters in a Reporting Services URL” on
page 52

“SQL Server Reporting Services Does Not Display the X-axis in Reports Where the Label
Interval Type is Set to Auto” on page 53

“Report Manager Does Not Work After You Enable FIPS-Compliant Algorithms in Local Security
Policy” on page 53

“SQL Server Reporting Services 2008 Does Not Correctly Display Reports Created from the
System Uptime Pie Chart Template” on page 53

“Create Data Mart Job Fails on Step 1 Post Upgrade” on page 54

“Report Display Incorrect Data” on page 54

“The w3wp.exe Process Consumes 100% CPU and High Memory” on page 54
“Unable to Export Reports in a Distributed Environment” on page 54
“Misleading Values in System Uptime Reports” on page 54

“Admin Console Does Not Respond When You Add a Data Source” on page 55
“Japanese Characters are Corrupted” on page 55

“Database Open Error” on page 55

“Error Connecting to the Remote Server” on page 56

“Reporting Services error” on page 56

“OLAP Processing Job Fails Because of Inaccessible Data Mart” on page 57
“Unable to Deploy or View Reports in SSRS” on page 57

“Unable to Run a Migrated Report That Has Default Metric Context Selection” on page 57
“Deployed Report Displays Empty Chart in SSRS” on page 58

“Unable to Cache the Information of a Report With a Long Name” on page 58

“Migrated Report That Fetch Data From AC_Configuration Database Fails to Run In Reporting
Console” on page 58

“Unable to Log Into the Reporting Console” on page 59

“Configuring and Generating Error Messages” on page 60

“Reporting Center Web Service Unavailable” on page 60

“No Data Found In a Report” on page 61

“Report Timeout Issues” on page 61

“Migrating Reports Having More Number of Objects Selected Fails During Upgrade” on page 63
“Unable to Log Into the Reporting Console On a German Locale Computer” on page 63
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+ “Dashboard Report Execution Fails For Reports That Does Not Have the Report Type” on
page 63

+ “Unable to Export Reports Through Analysis Center Console” on page 64

Error When Selecting a Data Source

Explanation: If you create a Data Mart on a SQL Server Failover Cluster and then select a
Data Source in the Admin Console, the following error might display: MSDTC on
server 'VSQ' is unavail abl e. This error occurs when the Virtual SQL
Server comes online before the Distributed Transaction Coordinator service has
started.

Action: Use the Failover Cluster Manager to take the Virtual SQL Server group offline,
and then bring it back online.

Report Data Mismatch in SQL Server Reporting Services and
Reporting Console
Explanation: If you modify the default Data Source Connection, the data displayed for an
already deployed report in SQL Server Reporting Services (SSRS) mismatches

with the data displayed for the same report in the Reporting
Console.( DOC337247)

Action: To match the SSRS report data with the Reporting Console data, you must save
the report again. To enable you to save the report, make any minor change in the
report and then save it.

Reporting Center Does Not Support Windows Accounts That
Contain Japanese Characters
Explanation: If you use a Microsoft Windows or a Microsoft SQL Server account that contains
Japanese characters to install Reporting Center on a computer, the installation

fails. This is because the setup program cannot verify accounts containing
Japanese characters. (ENG298142)

Action: To install Reporting Center, you must use an account that contains only English
characters.

Reporting Center Does Not Retrieve Japanese Characters in a
Reporting Services URL
Explanation: When you install the Reporting Services Data Extension component of Reporting
Center using a URL that contains Japanese characters, the SSRS URL does not
work. This is because the Default Report Server Location option in the

Reporting Services Options window does not display the Japanese characters
correctly.(ENG318142)

Action: Do one of the following to specify a valid URL:

+ To use the URL as the default SSRS location:

1. Go to the Microsoft SQL Server Reporting Services Configuration
Manager and copy the correct Web Service URL.

2. Open the Reporting Console.
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3. On the Main tab, click Options > Reporting Services Settings.

4. In the Default Report Server Location, paste the Web Service URL in
the following format:

http:// Server Nane/ WebSer vi ceURL
+ To use the URL for a specific report:

1. Go to the Microsoft SQL Server Reporting Services Configuration
Manager and copy the correct Web Service URL.

Launch the Reporting Console.

Click the report you want to deploy.

On the Report tab, click Deployment > Deploy Report.
Click SQL Server Reporting Services.

Click Add New Location.

N o o~ wDd

In the SQL Server Reporting Services Location [URL] option, paste
the URL in the following format:

http:// Server Nane/ WebSer vi ceURL

SQL Server Reporting Services Does Not Display the X-axis in
Reports Where the Label Interval Type is Set to Auto

Explanation: In reports deployed to SQL Server Reporting Services (SSRS), the X-axis labels
might not get displayed if the Label Interval Type for the X-axis is set to Auto in
the Reporting Console. ( DOC318485, DOC318507)

Action: In Reporting Console, open the report and ensure that the Label Interval Type
for the X-axis is not set to Auto. Then, redeploy the report.

Report Manager Does Not Work After You Enable FIPS-Compliant
Algorithms in Local Security Policy

Explanation: According to Microsoft Corporation, Microsoft SQL Server 2008 Reporting
Services and SQL Server 2008 R2 Reporting Services have the following
limitation:

Report Manager fails after you enabl e FIPS-conpliant algorithns in
the Local Security Policy. Report Manager does not support the
followi ng Local Security Policy: "System cryptography: Use FIPS
conpliant algorithms for encryption, hashing, and signing.”

Action: There is currently no workaround for this issue. For more information, see
Microsoft Web site (http://msdn.microsoft.com/en-us/library/ms345220.aspx).
For additional configuration options, see the Microsoft Knowledge Base article.

SQL Server Reporting Services 2008 Does Not Correctly Display
Reports Created from the System Uptime Pie Chart Template

Explanation: If you upgrade your setup to SQL Server Reporting Services (SSRS) 2008 and
deploy a report that was created by using the System Uptime Pie Chart template,
SSRS incorrectly displays a solid black chart in the report.

Action: Use the System Uptime Pie Chart template to recreate the report and then
deploy it again.
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Create Data Mart Job Fails on Step 1 Post Upgrade

Explanation: If you have more than one Data Source and upgrade to Analysis Center 3.0, the
Create Data Mart job fails on Step 1 for one of the Data Sources with the error:
Deadl ocked on | ock resources.

Action: This issue is automatically resolved on the next scheduled job run or you can
manually run the Create Data Mart job for each Data Source one at a time.

Report Display Incorrect Data

Explanation: In a generated report, Analysis Center might display a red cross instead of a
chart or table, or might not display a chart that it had previously displayed.

Action: Restart the Reporting Console.

The w3wp.exe Process Consumes 100% CPU and High Memory

Explanation: The w3wp.exe process consumes 100% CPU and high memory in the following
scenarios:

+ Report has data older than one year.

+ Report is run with several metrics selected and the time interval is set as
Minute or Hour.

+ Report takes a longer time to run than expected or completes with an error
message.

Action: Ensure that you selected valid parameters for the report and the report is
processing only the required data points.

Unable to Export Reports in a Distributed Environment

Explanation: Analysis Center installs the files required to export reports on the Data
Warehouse computer. If you have Analysis Center in a distributed environment,
then the files required to export reports are on the Data Warehouse computer
and not on the Console computer.

Action: To enable exporting reports in a distributed environment, copy the following files
from the bin folder on the Data Warehouse computer (typically C: \ Pr ogr am
Fil es\ Net | Q Anal ysi s Cent er\ bi n) to the console folder on the Console
computer (typically C:\ Program Fi | es\ Net | Q Anal ysi s Center\consol e):
¢ XM.Checkl n. exe
¢ XM.Checkl n. exe.config
¢ XM.Checkl nLi b. dl |

¢ Wn32Security.dll

Misleading Values in System Uptime Reports

Explanation: System Uptime reports display the value 1 for up and 0 for down. If you set the y-
axis labels format to percentage values instead of the NumericFormat, the
results can be misleading. In addition, changing the NumericFormat to P5
(percentages with five decimal places) causes the table to display incorrect
values.
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Action: The format of y-axis labels in System Uptime Reports must be NumericFormat.

Admin Console Does Not Respond When You Add a Data Source

Explanation: On a Windows Server 2003 or Windows Server 2008 computer that hosts an
Analysis Center related SQL Server or Analysis Services server, Admin Console
fails to respond when you add a Data Source that references the SQL or
Analysis Services server on that computer. This happens if MSDTC for network
access is not configured for that computer.

Action: To configure MSDTC for network access on Windows Server 2003:
1 Launch the programs on the Start menu and click Administrative Tools >
Component Services.

2 Expand Component Services > Computers. Right-click My Computer and
click Properties.

3 Click the MSDTC tab and click Security Configuration.
4 Select the Network DTC Access option and click OK twice.
5 Reboot the computer to apply the changes.
To configure MSDTC for network access on Windows Server 2008:
1 Launch the programs on the Start menu and click Administrative Tools >

Component Services.

2 Expand Component Services > Computers > My Computer > Distributed
Transaction Coordinator.

3 Right-click Local DTC and click Properties.
4 Click the Security tab and select the Network DTC Access option.
5 Click OK and the changes are immediately effective.

Japanese Characters are Corrupted

Explanation: If you are using data from an AppManager repository installed on a computer
using the Japanese locale, the Japanese characters might get corrupted if the
corresponding Data Mart computer and the Reporting Console computer does
not use the Japanese locale.

Action: Ensure that the corresponding Data Mart computer uses the Japanese locale
and the system language settings for the Reporting Console computer is also set
to include Japanese.

Database Open Error

Explanation: You might encounter the following error if the Remote Registry service is not
running on all Analysis Center computers:

###--> ERROR » - Error: -2147467259
Description: Cannot open database requested in login
"AC Configuration'. Login fails.

Action: Ensure that the Remote Registry service is running on all Analysis Center
computers.
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Error Connecting to the Remote Server

Explanation: You might encounter the following error message when connections between

Action:

Analysis Center components are lost:

The underlying connection was cl osed: Unable to connect to the
renote server

This might happen if a physical network connection is lost because the computer
is unplugged from the network, the 1IS server hosting the Web Service is not
running, or the router is not up.

Ensure that the Analysis Center components are connected.

Reporting Services error

Explanation:

Troubleshooting

Action:

The following error message is displayed in Report Manager when the
connections, SQL Reporting Services to Data Extension to Web Service to Data
Warehouse, required to process a report cannot be established:

"An error has occurred during report processing... Cannot create a
connection to data source... The request failed with HTTP status
401: Access Denied."

This error occurs in the following scenarios:

+ You have selected Windows NT Integrated Security as the Report Server
Credentials when deploying a report.

+ Reporting Center components are distributed among a number of
computers.

Under these circumstances, you encounter the Windows “double-hop” issue
in which Windows security credentials are not recognized for more than one
connection. Credentials are recognized from Server A to Server B, but not
from Server B to Server C.

To overcome this problem, select the Credentials configured with a shared data
source option in Data Source Authentication page when deploying a report and
create a shared Data Source with the Credentials stored securely in the report
server option selected.

To set the Credentials stored securely in the report server property for a Data
Source, use Report Manager to edit the Data Source properties:
1 Select the Data Source in Report Manager.

2 In the Connect Using section, select the Credentials stored securely in the
report server option.

3 Enter the User name (<donai n\ user >) and Password.

Do not select either of the following options: Use as Windows credentials or
Impersonate the authenticated user. The Analysis Center Web Service
handles authentication of the user to the Data Warehouse.

4 Click Apply.



To set the Credentials stored securely in the report server property for a
deployed report:

1 Open the Properties page for the report in Report Manager.
2 Click the Data Sources link on the Properties page.

3 Select A custom Data Source.
4

In the Connect Using section, select Credentials stored securely in the
report server.

5 Enter the user name (<donai n\ user >) and password.

Do not select either of the two options Use as Windows credentials or
Impersonate the authenticated user. The Analysis Center Web Service
handles authentication of the user to the Data Warehouse.

6 Click Apply.

OLAP Processing Job Fails Because of Inaccessible Data Mart

Explanation: If you add a Data Source for which the Data Mart does not exist or is
inaccessible, you might encounter problems when you attempt to delete the Data
Source. In this scenario, the first run of the OLAP processing job fails after you
delete the Data Source.

This failure causes no real problem in Analysis Center. The second run of the
OLAP processing job succeeds. The Data Mart might not be accessible because
incorrect authentication credentials were provided when creating the Data
Source.

Action: To avoid the OLAP job failure, when deleting a Data Source that has an
inaccessible Data Mart, you must not delete the Data Mart database. When
prompted to remove the Data Mart database, select No.

Unable to Deploy or View Reports in SSRS

Explanation: If you log in to Reporting Console without administrator privileges, you cannot
deploy reports to SSRS or view reports in SSRS.

Action: To resolve this issue, you must create a new role in SSRS that has permission to
view and deploy the reports. For information about adding user or group to a
system role, see the Microsoft article: http://msdn.microsoft.com/en-us/library/
ms156034.aspx.

Unable to Run a Migrated Report That Has Default Metric Context
Selection

Explanation: If you save a report without selecting any context in Analysis Center Console, the
console applies default context to the report. If you migrate such a report that has
default Metric context selection to Reporting Console, the default Metric context
selection is not saved during migration. When you run this migrated report in
Reporting Console, the console displays an error.
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Action: To resolve this issue, do one of the following:

+ Before you migrate the report, select the required Metric context.

+ After you migrate the report with the default selection, select the required
Metric context before you run the report.

Deployed Report Displays Empty Chart in SSRS

Explanation: If you deploy a report as a Bar chart with many values on X-axis, then the report
displays an empty chart in SSRS.

Action: Do one of the following:
+ To continue plotting the report as a Bar, reduce the number of data points on
the X-axis.

+ To continue plotting the report with many data points on X-axis, change the
chart type to Area.

Unable to Cache the Information of a Report With a Long Name

Explanation: When you run a report, the report is cached by default in the
Appl i cati onDat aFol der\ Local \ Net | Q Reporti ng Center\ReportCache
folder. If the complete path of the cached file exceeds 260 characters, the report
caching fails. This might be either because of a longer report file name or the
ApplicationDataFolder path in the report cache file path might be too long.

Action: To enable caching of such reports, do one of the following:
+ (Conditional) If the report name is too long, rename the report with a shorter
name.

+ (Conditional) If the report cache file path is too long, then do the following:
1. Runregedit.exe to open the Registry Editor.
2. Locate HKLM SOFTWARE\ Net | Q. Reporti ngCent er\ Consol e
3. Create a new String with the following values:

+ Name: Specify Repor t CachePat h.

+ Data: Specify a new report cache path such that the complete
path of the cached file does not exceed 260 characters. For
example: D: \ Net | QRepor t Cache.

4. To retain the caching information, copy the content of the old report
cache folder to the new report cache folder.

Migrated Report That Fetch Data From AC_Configuration Database
Fails to Run In Reporting Console

Explanation: If you migrate a report, such as Li cense Usage and Li censes, that retrieves
data from the AC_Configuration database, the report fails to run in the Reporting
Console with the following error:

Coul d not find stored procedure

Troubleshooting



Action: Do the following to create a new Data Source Connection for the
AC_Configuration database and set the Data Source connection of the migrated
report to this new connection:

1. Create a new Data Source connection for AC_Configuration database:

a. In the Navigation pane of the Reporting Console, right-click Data
Source Connections and click Add New Data Source Connection.

Click the General tab.

Specify the Data Source connection name and description.

Ensure that the Default Connection option is not selected.

Select the Data Source Type as Analysis Center.

In the SQL tab of the Connection Details panel, specify the following:

i. Inthe Server Name option, specify the SQL Server Instance name
where AC_Configuration is installed.

-~ ® 2 o T

ii. Inthe Database Name option, specify AC_Configuration.
iii. Select the authentication type.

iv. (Conditional) If you choose SQL Server Authentication, then
specify the credentials to log into the SQL Server.

g. Inthe OLAP tab of the Connection Details panel, specify the following:

i. Inthe Server Name option, specify the SQL Server Instance name
where AC_OLAP is installed.

ii. Inthe Database Name option, specify AC_OLAP.
h. Click OK.

2. Set the Data Source connection of the migrated report to the newly created
connection:

a. Select the migrated report.

b. Inthe Data Source Connection Name option of the Report Contexts
tab, select the new connection name you created.

3. Save and run the report.

Unable to Log Into the Reporting Console

Explanation: If you installed the Reporting Center Web Service using a SQL account and
subsequently changed the password on that account, the following error
message is displayed when you log into the console:

Login Error: Login failed for user <SQ User Account> using the
SQ. account.

Action: Do the following:

1 Uninstall the Reporting Center Web Service and reinstall it using the new
SQL password. This does not affect your reports.

2 In the Reporting Console, re-enter the SQL password in the Data Source
Connection Properties window.

Explanation: For IIS 7.0 or later, in the NRCWebService Virtual Directory, Windows
Authentication is enabled and ASP.NET Impersonation Authentication is
disabled by default. If the Virtual Directory is no longer configured this way, you
cannot log in to the Reporting Center Web Service.
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Action: To configure authentication settings in 1IS 7.0 or later:
1 Start IIS Manager on the computer where you installed the Web Service,
and expand the Web Sites folder.

2 Expand the name of Web Site where you installed the Web Service, and
click NRCWebService.

3 Inthe IIS section of the center pane, double-click Authentication.

4 (Conditional) If ASP.NET Impersonation is enabled, select it and click
Actions > Disable.

5 (Conditional) If Windows Authentication is disabled, select it and click
Actions > Enable.

6 Close IIS Manager.

Configuring and Generating Error Messages

Explanation: If IS Manager is displaying generic error messages, you can configure Internet
Explorer to display more technical error messages.

Action: To configure error messages in Internet Explorer:

1 Click Tools > Internet Options.

2 Click the Advanced tab and deselect the Show Friendly HTTP Error
Messages option in the Browsing list.

3 In lIS Manager, generate the Default Web Site error or Web Service error
again to obtain more detailed information and contact NetlQ Technical
Support (http://www.netiq.com/Support/contactinfo.asp).

Reporting Center Web Service Unavailable

Explanation: If you log in to the Reporting Console and the Reporting Center Web Service is
unavailable, the following message is displayed:

Wb Service ‘WebServiceURL’ is currently unavail abl e.
Possible Cause: Reporting Center Application Pool (NRCAppPool) might not be running.

Action: Ensure that the Reporting Center Application Pool (NRCAppPool) is installed
and running. If NRCAppPool is not running, do the following to manually restart
NRCAppPool in 1IS Manager and then log in to the Reporting Console again:

1 Start IIS Manager on the server hosting the Reporting Center Web Service,
and expand Application Pools.

2 Right-click NRCAppPool and select Start.
3 Close IIS Manager.

Possible Cause: NRCAppPool Identity user account, the Windows account used to install the
Reporting Center Web Service user, has expired.
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Action: Ensure that the NRCAppPool Identity user account is not expired. If the user
account has expired, do the following to reactivate the account and reset the
password.

1 Start IIS Manager on the server hosting the Reporting Center Web Service,
and expand Application Pools.
2 (Conditional) If you are running 1S 6.0:
2a Right-click NRCAppPool and select Properties. Click the Identity tab.
2b Click Configurable, enter the Identity user credentials, and click OK.
2c¢ Right-click NRCAppPool and select Start.
3 (Conditional) If you are running 1S 7.0 or later:
3a Select NRCAppPool.

3b From the Action pane to the right of the Application Pools list, click
Advanced Settings.

3c In the Process Model section, select Identity and click Custom
account.

3d Click Set, and enter the Identity user credentials in the Set Credentials
window.

3e Click OK to close the Set Credentials window, the Application Pool
Identity window, and the Advanced Settings window.

3f Right-click NRCAppPool and select Start.

No Data Found In a Report

Explanation: On executing a report, if the Reporting Console displays one of the following
errors, the report might not contain data for the contexts specified in the report:

¢+ No Data
¢ Syntax Error (Ona German locale computer)

Action: Check if Reporting Center can retrieve data for a broader range of contexts, such
as a greater time or date range. To verify if the data is beyond the current context
configuration:

1 Inthe Context Pane of the Reporting Console, change the relevant contexts
to include a broader date range or more information. For example, selecting
more items in a navigation tree.

2 Click Run Report.

If the report contains data, the Reporting Console displays the information
according to the contexts you reconfigured. This indicates that Reporting
Center had originally executed the report correctly, but had no data to
retrieve for the specified contexts.

Report Timeout Issues

Explanation: You might encounter report timeout issue because of connection errors. If you
run reports that return large data sets, the time required for the report execution
might exceed the connection timeout setting configured for the data source.
Consequently, the report execution times out.
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Action: To avoid this timeout issue, increase the value of the Ti meout attribute for each
Connect i on element before you execute the report. This Ti meout attribute is
listed in the XM column of the NQRConf i g database Dat aSour ce table. By
default, the Ti mreCQut value is 3600 seconds. A value of 0 indicates no timeout
limit and the report query executes indefinitely.

Sample of the XM_ column content:
<Ext Dat aSour ce Nane="dat asource name"
Dat aSour ceType="dat asour ce_t ype" Descri pti on="dat asour ce_desc"
Def aul t Connect i on="no_of _defaul t _connecti ons">
<Connecti on Name="name" Server="ServerNanel"
Dat abase="dat abase_nane" Ti neCQut ="3600" />
</ Ext Dat aSour ce>
To change the value of the Ti meCut attribute that is listed in the XM. column of
the NQRConf i g database Dat aSour ce table, do the following:
1 Open the NRC. Ext Dat aSour ce. xni file that is available in the
\ Net I Q ReportingCenter\Config\ folder.
NOTE: The NRC. Ext Dat aSour ce. xni file opens as Read-only mode. You
must change to Write mode to edit it.
2 Modify the Ti meQut attribute value of the <Connection> element based on
your report execution time.
3 Check in the NRC. Ext Dat aSour ce. xni file by using the following command
at the command prompt:
XM.Checki n. exe <SQ.Server named instance> "Path for the xni
file"
For example: XM_Checki n. exe <NQRConfi g Dat abase
Server >"E:\ NRC\ NRC. Ext Dat asour ce. xm "
NOTE: The XMLCheckin.exe file is available in the
\'Net | Q ReportingCenter\UWilities folder.
You can also increase the value for the execut i onTi neout attribute of the
<ht t pRunt i me> element, which governs the length of time a request is allowed
to run before ASP.NET automatically shuts it down. Add the following
<ht t pRunt i me> element within the <syst em web> section of the Wb. confi g
file, which is availble in the \ Net | Q Reporting Center\WbServi ce folder. Set
the execut i onTi mout value to match the Ti meQut values you set for the
<Connect i on> element.
<htt pRunti ne executi onTi neout =" 3600"
nmaxRequest Lengt h="4096"
useFul | yQual i fi edRedi rect Ur|l ="f al se"
m nFreeThr eads="8"
m nLocal Request Fr eeThr eads="4"
appRequest QueuelLi m t ="100" />
Explanation: When loading a report or importing a large number of reports, you might
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Action: To avoid this timeout issue, increase the value for the Ti neQut attribute in the
Connect i on element of the Wb. confi g file on the Web Ser vi ce website. By
default, the Ti neQut value is 3600 seconds.

<Connecti ons>
<Connection Nane="Config" Server="ServerNanel"
Dat abase="NQRConf i g" Ti neCut ="3600" ConnectionType="SQ" />
</ Connecti ons>

You can also increase the value for the execut i onTi neout attribute of the

<ht t pRunt i me> element, which governs the length of time a request is allowed

to run before ASP.NET automatically shuts it down. Add the following

<ht t pRunt i me> element within the <syst em web> section of the Web. confi g file
which is availble in the \ Net | Q Reporting Center\WbServi ce folder. Set the
execut i onTi mout value to match the Ti meCQut values you set for the

<Connect i on> element.

<htt pRunti ne executi onTi neout =" 3600"
maxRequest Lengt h="4096"

useFul | yQual i fi edRedi rect Ur|l ="f al se"
m nFreeThr eads="8"

m nLocal Request Fr eeThr eads="4"
appRequest QueueLi mi t ="100" />

Migrating Reports Having More Number of Objects Selected Fails
During Upgrade
Explanation: When you upgrade Data Warehouse on a computer, if you choose to migrate a

report that has a large number of objects selected, the migration of all the
selected reports fails.

Action:  To continue migrating reports during upgrade, do not select the report that has a
large number of object selections. You can migrate this report post upgrade. To
migrate this report, export the report using Analysis Center Console and import it
to Reporting Console.

Unable to Log Into the Reporting Console On a German Locale
Computer

Explanation: Logging into Reporting Console on a German locale computer fails with error
suchas:"404 - File not found","401 - Unaut horized" or"500 - Server
Error”

Action: On the computer where Web Service is installed, edit the
Instal | Dir\Reporting Center\WbService\Wb. confi g file to remove the
following line:

<httpErrors errorMde="Detail ed" />

Dashboard Report Execution Fails For Reports That Does Not Have
the Report Type

Explanation: If you run a Dashboard, all the Dashboard reports that do not have the report
type specified in the <NQREPORT> tag of the report XML file fails to execute.
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Action: Do the following:

1 Select the Dashboard.
2 Click Report > Export Report Definition to export the Dashboard definition.

3 In the exported Dashboard XML file, if the value for Type attribute in the
<NQREPORT> tag is empty, then set the value to Anal ysi sCent er . ACOLAP.

4 Import the modified XML and run the Dashboard.

Unable to Export Reports Through Analysis Center Console

Explanation: If exporting one or more reports through the Analysis Center Console fails then
the subsequent export of reports through the console might also fail. This is
because the temporary information stored during a failed export is not yet
cleared from the export tables.

Action:  On the SQL server that has Data Warehouse installed, run the following
command to manually clear all the temporary information:

USE [ AC_Confi guration]

Del et e RepExport Report

Del et e RepExport Report Cont ext

Del et e RepExport Report Cont ext Node
Del et e RepExport Report El enent

Del et e RepExport Set
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